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PREFACE
Every effort has been made to ensure that the information in this document is complete, 
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of 
errors beyond its control. The manufacturer also cannot guarantee that changes in software 
and equipment made by other manufacturers and referred to in this guide will not affect 
the applicability of the information in it. Mention of software products manufactured by 
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful 
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or 
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:

www.okiprintingsolutions.com

07111701 Iss.01; Copyright © 2010 Oki Europe Ltd. All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Hewlett-Packard, HP, and LaserJet are registered trademarks of Hewlett-Packard 
Company.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

ENERGY STAR is a trademark of the United States Environmental Protection Agency.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their 
proprietors.

As an ENERGY STAR Program Participant, the manufacturer has determined 
that this product meets the ENERGY STAR guidelines for energy efficiency.1

This product complies with the requirements of the Council Directives 2004/
108/EC (EMC), 2006/95/EC (LVD),1999/5/EC (R&TTE) and 2009/125/EC 
(ErP), as amended where applicable, on the approximation of the laws of the 
member states relating to Electromagnetic Compatibility, Low Voltage, Radio 
& Telecommunications Terminal Equipment and Energy Using Products. 

The following cables were used to evaluate this product to achieve EMC directive
2004/108/EC compliance and configurations other than this may affect that compliance.

1. If the centronics (parallel) port is enabled, the product is no longer Energy Star compliant.

CABLE TYPE LENGTH 
(METRE)

CORE SHIELD

Power 1.8 ✘ ✘

USB 5 ✘ ✔

Parallel 1.8 ✘ ✔

LAN 15 ✘ ✘
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EMERGENCY FIRST AID
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO 
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical 
attention.

If it gets into the eyes, flush with large amounts of water for at least 15 
minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of 
staining skin or clothing.

MANUFACTURER
Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

IMPORTER TO THE EU/AUTHORISED REPRESENTATIVE
Oki Europe Limited (trading as OKI Printing Solutions)
Blays House
Wick Road
Egham
Surrey TW20 0HJ
United Kingdom

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION
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NOTES, CAUTIONS AND WARNINGS

For the protection of your product, and in order to ensure that you benefit from its full 
functionality, this model has been designed to operate only with genuine original toner 
cartridges. Any other toner cartridge may not operate at all, even if it is described as 
“compatible”, and if it does work, your product's performance and print quality may be 
degraded.

Specifications subject to change without notice. All trademarks acknowledged.

NOTE
A note provides additional information to supplement the main text. 

CAUTION!

A caution provides additional information which, if ignored, may 
result in equipment malfunction or damage.

WARNING!

A warning provides additional information which, if ignored, may 
result in a risk of personal injury.
Notes, cautions and warnings > 6



ABOUT THIS GUIDE

DOCUMENTATION SUITE

This guide is part of a suite of online and printed documentation provided to help you 
become familiar with your product and to make the best use of its many powerful features. 
The documentation is summarised below for reference and is found on the manuals DVD 
unless indicated otherwise:

> Installation Safety booklet: provides information for safe use of your product.

This is a paper document that is packaged with the product and should be read before 
setting up your machine.

> Set-up guide: describes how to unpack, connect and turn on your product.

This is a paper document that is packaged with the product.

> User’s Guide: helps you become familiar with your product and make the best use 
of its many features. Also included are guidelines for troubleshooting and 
maintenance to ensure that it performs at its best. Additionally, information is 
provided for adding optional accessories as your printing needs evolve.

> Network Guide: helps you become familiar with the functionality of the built in 
network interface card.

> Security Guide: helps you become familiar with your product’s security features.

> Installation Guides: accompany consumable items and optional accessories to 
describe how to install them.

These are paper documents that are packaged with the consumables and optional 
accessories.

> On-line Help: on-line information accessible from the printer driver and utility 
software.

NOTE
Images used in this manual may include optional features that your product 
does not have installed.
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ON-LINE USAGE

This guide is intended to be read on screen using Adobe Reader. Use the navigation and 
viewing tools provided in Adobe Reader.

There are many cross-references within this book, each highlighted as blue text. When you 
click on a cross-reference the display will instantly jump to the part of the manual 
containing the referenced material. 

By using the  button in Adobe Reader, you can navigate directly back to where you were 
before.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of 
interest to jump to the required topic. (If the bookmarks are not available, use the 
“Contents” on page 4.)

> In the list of bookmarks, click on Index to jump to the Index. (If the bookmarks are 
not available, use the “Contents” on page 4.) Find the term of interest in the 
alphabetically arranged index and click on the associated page number to jump to 
the page containing the term.

PRINTING PAGES

The whole manual, individual pages, or sections may be printed. The procedure is:

1. From the toolbar, select File > Print (or press the Ctrl + P keys).

2. Choose which pages you wish to print:

(a) All pages, (1), for the entire manual.

(b) Current page, (2), for the page at which you are looking.

(c) Pages from and to, (3), for the range of pages you specify by entering their 
page numbers.

(d) Click OK.

1 
2 
3 
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INTRODUCTION
Congratulations on purchasing this monochrome page printer.

Your new printer is designed with a range of advanced features to give you crisp black and 
white pages at high speed on a wide range of print media.

For your information, a summary of the main features of your printer is given below.:

> Two different models to choose from: B840n and B840dn
(d denotes Duplex included and n denotes Network Interface Card included).

> Memory: 128MB.

> Paper handling: 530 sheets (80g/m²).

> Emulation: standard Printer Control Language PCL5e, PCLXL, Epson FX, IBM 
ProPrinter and PostScript3.

> Barcodes: embedded for SIDM emulations.

> USB 2.0 High speed and Parallel interfaces.

> 10/100 BASE-TX Network: lets you share this valuable resource among users on 
your office network.

> Multi Purpose tray: to extend the range of media your printer can accommodate 
(capacity 100 sheets (80g/m²) or 10 envelopes), and can also use as manual 
duplex.

> “Ask Oki” – a user-friendly function that gives a direct link from your printer driver 
screen (but not illustrated in this guide) to a dedicated web site specific to the exact 
model you are using. This is where you’ll find all the advice, assistance and support 
you could need to help you get the best possible results from your Oki printer.

Additionally, the following optional features are also available:

> 256, 512MB RAM DIMM: to extend the main memory of your printer and speed up 
the processing of large files.

> SD card for storage of overlays, macros and downloadable fonts, and automatic 
collation of multiple copies of multipage documents.

> Additional paper tray: to increase your printer’s paper handling capacity by 530 
sheets (80g/m²).



PRINTER COMPONENTS
For illustration purposes the B840dn model is shown.

1. Operator panel

2. Output Stacker (250 sheets @ 80g/m2, face down)

3. Output Stacker extension

4. Top cover release button

5. Multi Purpose Tray (100 sheets @ 80g/m2)(shown in open position)

6. Multi Purpose Tray extension

7. Paper size dial

8. Paper Tray (530 sheets @ 80g/m2)

9. ON/OFF switch

10. LED array

11. Fuser unit

12. EP toner cartridge

13. Top cover

1
24
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7
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14. Cooling fan

15. Power cable connection

16. Parallel interface connection

17. LAN interface connection

18. ACC connection

19. USB interface connection

20. Paper Tray extension

21. Duplex unit (optional on the B840n)

22. Rear Face Up Tray extension 

23. Rear Face Up Tray

21

20

22

23

15
19
18
17

16

ACC

LAN

14
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OPERATOR PANEL

The operator panel consists of a menu driven control panel, an LCD display and two LED 
indicators.

PANEL ELEMENTS

1. Liquid crystal display. (LCD) panel. Two rows of up to 16 alphanumeric digits 
displaying print status, menu items in menu mode and error messages. 

2. Menu Scroll Buttons. Press briefly to enter the MENU mode. Press briefly again to 
select the next menu. Press for more than 2 seconds to scroll through the different 
menus.

3. Back button. Press briefly to return to the previous higher level menu item or exit 
the menu when in MENU mode. In the ONLINE or OFFLINE mode/MENU mode: when 
pressed for 4 seconds, the printer starts to shutdown.

4. ENTER button. In the ONLINE or OFFLINE mode: press this briefly to enter the MENU 
mode. In the MENU mode: press this briefly to select the menu or setting indicated on 
the LCD. When pressed for 2 seconds or longer, it reverts to the previous menu item.

5. On Line button. Press to switch between ONLINE and OFFLINE status.
Press to exit the menu and displays ONLINE, when in the MENU mode. 

6. Cancel button. When printing press to cancel a print job. Press to exit the MENU 
mode and go ONLINE, when in the MENU mode. 

NOTE
When pressed with DATA displayed (press and hold for five seconds), it forces 
the printer to print out the remaining data in the printer.

NOTE
When pressed in Menu mode, the Online button returns the printer to ONLINE 
status. Also when there is an error indicating wrong paper size, pressing the 
Online button forces the printer to print.

When pressed in Sleep Mode, the Online button returns the printer to ONLINE 
status.

When manually feeding paper, pressing the Online button will start the 
printing.

NOTE
When there is an error, and there are print jobs in queue, pressing the Cancel 
button deletes the first job in the queue.

8

17

3 4

652
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7. Ready indicator (green). ON indicates ready to receive data. FLASHING 
indicates processing data. FLASHING SLOWLY indicates the machine status is 
sleep mode. OFF indicates Offline.

8. Attention indicator (red). ON indicates a warning (e.g. low toner). FLASHING 
indicates an error, (e.g. toner empty). OFF indicates normal condition.

CHANGING LANGUAGE

The default language used by your printer for display messages and for report printing is 
English. If required, this can be changed to:

POWER SAVING MODE 

If you do not use the machine for a while, it will enter the power saving mode to control 
the power consumption of the device. To cancel power saving mode, press the On Line 
button on the control panel.

SWITCHING OFF 

1. Press the Enter button on the control panel to enter the menu.

2. Press the Menu down button and scroll to the SHUTDOWN MENU.

3. Press the Enter button.

4. Press the Enter button to execute.

5. At the prompt, turn the power switch OFF.

NOTE
If both the Ready and Attention indicators are flashing, tThere is a minor error 
with the printer, for example, toner is low and the image drum needs to be 
changed.

German Danish Swedish Polish

French Dutch Russian Greek

Italian Turkish Finnish Czech

Spanish Portuguese Hungarian Norwegian

NOTE
1. The Operator Panel Language Setup Wizard will run automatically when 

you install the printer driver. Follow the instructions provided by this 
utility to set your chosen language.

2. The list above is neither conclusive nor exhaustive.

CAUTION!

If you have an SD card fitted, always follow the correct shutdown 
procedure to ensure that no data is lost.

NOTE
Alternatively, pressing the Back button for longer than 4 seconds will display 
the SHUTDOWN MENU.
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MENU FUNCTIONS

HOW TO CHANGE THE SETTINGS - USER

It should be noted that many of these settings can be, and often are, overridden by settings 
in the Windows printer drivers. However, several of the driver settings can be left at 
“Printer Setting”, which will then default to the settings entered in these printer menus.

Where applicable, factory default settings are shown in bold type in the following tables.In 
the normal operating condition, known as “standby,” the printer’s LCD window will show 
“ONLINE.”

In this condition, to enter the menu system, press the up and down Menu buttons on the 
operator panel to move up and down through the list of menus until the menu you wish to 
view is displayed. Then proceed as follows:

1. Press Enter to enter the menu.

2. Use the up or down Menu buttons on the control panel to scroll through the menus. 
When the item you want to change is displayed, press Enter to view the sub-menus 
for that item.

3. Use the up or down Menu buttons to move up and down through the sub-menu 
items. When the item you want to change is displayed press Enter to display the 
setting.

4. Use the up or down Menu buttons to move up and down through the available 
settings for the sub-menu item. When the item you want to change is displayed 
press Enter to display the setting. An asterisk (*) will appear next to the setting, 
indicating that this setting is currently in effect.

5. Do one of the following:

> Press Back again to move up to the list of menus;

or…

> Press On Line or Cancel to exit from the menu system and return to standby.

HOW TO CHANGE THE SETTINGS - ADMINISTRATOR

You can set whether to ENABLE or DISABLE each category in the user menu.

Disabled categories are not displayed in the User’s menu. Only a system administrator can 
change these settings.

1. Turn OFF the printer.

2. Turn ON the printer while pressing the Enter button.
When ADMIN MENU appears, take your finger off the button.

3. Press the Enter button.

4. At the ENTER PASSWORD prompt, enter the Admin password:

(a) Using the up and down MENU buttons, scroll to the required letter/digit.

(b) Press the Enter button to input and move to the next letter/digit.

(c) Repeat steps (a) and (b) until all letters/digits are entered.

Enter your 4 to 9 digit password.

(The default password is aaaaaa).

5. Press the Enter button.

6. Press the up or down Menu button until the “category” you want to change is 
displayed.
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7. Press the Enter button.

8. Press the up or down Menu button until the “item” you want to change is displayed.

9. Press the Enter button.

10. Using the up or down Menu button, identify the parameter as required.

11. Press the Enter button to enter an asterisk (*) on the right side of the setting 
selected.

12. Press the On Line button to switch to online. The machine will automatically re-
boot.

MENUS

Factory default settings are shown in the following tables.

NOTE
This guide is written to cover a number of models and as such may reference 
menu items or features that your machine does not have installed or does not 
support.
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PRINT JOBS MENU

NOTE
This menu only displays if the optional SD card is installed.

ITEM ACTION REMARKS

ENCRYPTED JOB NOT FOUND

PRINT

DELETE

Used for printing an encrypted authentication print 
job (Encrypted Job) stored in the SD card.

After inputting a password, “SEARCHING JOB” is 
displayed until a job appropriate to the password is 
found.

(Searching time increases in proportion to the 
number of jobs stored in the SD card, and the 
printer may take up to 20 sec.)

The search can be cancelled by holding down the 
CANCEL button.

“NOT FOUND” will be displayed where a file is 
unavailable.

One of the following messages will appear if a 
printable file is available.

ENCRYPTED JOB

PRINT

DELETE

If PRINT is selected, ALL jobs will be printed.

If DELETE is selected, the following message will 
appear.

ARE YOU SURE?

YES

NO

If NO is selected you will return to the source 
MENU. If YES is selected, ALL jobs will be deleted.

Print jobs with encrypted authentication stored in 
the SD card are deleted by a delete method 
specified by the driver after printing or a delete 
instruction from the menu.

STORED JOB NOT FOUND

PRINT

DELETE

Used to print out a stored job in the SD card.

“NOT FOUND” will be displayed where a file is 
unavailable.

One of the following messages will appear if a 
printable file is available.

STORED JOB

PRINT

DELETE

If PRINT is selected, COLLATING AMOUNT is 
displayed and the number of pages to print can be 
specified. Press the Enter button.

All specified pages will be printed.

If DELETE is selected, the following message will 
appear.

ARE YOU SURE?

YES

NO

If NO is selected you will return to the source 
MENU. If YES is selected, ALL jobs will be deleted.
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INFORMATION MENU

This menu provides a quick method of listing various items stored within the printer.

SHUTDOWN MENU

This item should always be selected before switching the printer off, to ensure that no data 
is lost.

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE Prints complete menu listing with current settings 
shown.

NETWORK EXECUTE Prints Network configuration information.

PRINT FILE LIST EXECUTE Prints a list of overlays, macros, fonts and other files 
stored on the printer’s SD card (if installed).

PRINT PCL FONT EXECUTE Prints complete list of all internal PCL fonts plus 
those stored in ROM (slot 0), flash memory and SD 
card (if installed).

PRINT PSE FONT EXECUTE Prints complete list of all internal PostScript 
emulation fonts.

PRINT PPR FONT EXECUTE Prints complete list of all internal IBM ProPrinter III 
XL emulation fonts, including any downloaded to 
flash memory or SD card (if installed).

PRINT FX FONT EXECUTE Prints complete list of all internal Epson FX emulation 
fonts, including any downloaded to flash memory or 
SD card (if installed).

DEMO32 EXECUTE Prints demonstration page containing graphics and 
text.

PRINT ERROR LOG EXECUTE Prints a list of all errors and warnings experienced.

USAGE REPORT EXECUTE Prints a list of pages printed.

ITEM ACTION REMARKS

SHUTDOWN START EXECUTE Performs controlled shutdown of the printer.

Only power the printer off when the display indicates 
that shutdown is complete.
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PRINT MENU

This menu provides adjustment of various print job related functions.

ITEM DEFAULT REMARKS

COPIES 1 Enter the number of copies of a document to be 
printed from 1 to 999.

DUPLEX OFF Switches the Duplex (2 sided) function ON/OFF. 
Duplex must be fitted.

BINDING LONG EDGE Sets the default binding to SEF or LEF.Display 
condition: duplex setting is enabled. 

See “DUPLEX” on page 18.

PAPER FEED TRAY1 Selects the default tray for paper feed, Tray 1 
(upper), Tray 2 (lower, if installed) or MP Tray (multi 
purpose tray).

AUTO TRAY SWITCH ON If two trays contain identical paper, the printer can 
switch to an alternative source when the current tray 
runs out in the middle of a print job.

TRAY SEQUENCE DOWN Determines tray sequence order when automatically 
switching.

MP TRAY USAGE DO NOT USE If a document to be printed demands a paper size not 
installed in the selected tray, the printer can 
automatically feed from the multi purpose tray 
instead. If this function is not enabled, the printer will 
stop and request the correct size of paper to be 
loaded.

MEDIA CHECK ENABLE Determines whether the printer check the size of 
paper loaded matches that required for the document 
sent to print.

RESOLUTION 600DPI Sets the default resolution for printing (dots per inch). 
1200DPI uses more memory and requires more time 
to process, but prints at a higher quality.

TONER SAVE MODE DISABLE Use less toner 10pt characters print legibly, but 8 pt 
characters do not. 

ORIENTATION PORTRAIT Selects default page orientation between portrait 
(tall) and landscape (wide). - (PCL, IBMPPR & EPSON 
FX only)

LINES PER PAGE 64LINES Sets the number of lines of text per page when raw 
text is received from systems other than Windows. 
The default for A4 portrait is 64, and for Letter is 60. - 
(PCL only)

EDIT SIZE CASSETTE SIZE Sets the size of the printable page area to match the 
size of paper in use. This is not the same as the 
physical paper size, which is always slightly larger. 
For dimensions of physical page sizes, see “Paper 
recommendations” section in this guide.

X SIZE 210MILLIMETER Specifies paper width of Custom paper as a default 
value.

Sets a paper size at right angles to the paper run 
direction.

Y SIZE 297MILLIMETER Specifies paper length of Custom paper as a default 
value.

Sets a paper size in the same direction as the paper 
run direction.
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MEDIA MENU

This menu provides adjustment to suit a wide range of print media.

ITEM DEFAULT REMARKS

TRAY1 PAPERSIZE CASSETTE SIZE Selects the size of paper loaded in Tray 1 (upper tray 
if both trays installed). For CUSTOM setting see X-
SIZE and Y-SIZE in “Print menu” on page 18.

TRAY1 MEDIATYPE PLAIN Selects the type of media loaded in this tray. This 
will help the printer to adjust its internal operating 
parameters, such as engine speed and fusing 
temperature, to better accommodate the media to 
be fed. For example, letterhead may benefit from a 
slightly lower fusing temperature to ensure that its 
ink does not offset.

Note: USERTYPEn are displayed only if registered in 
the host PC/Server.

TRAY1 MEDIAWEIGHT MEDIUM Adjusts the printer for the weight of paper stock 
loaded in this tray.

TRAY1 LEGAL SIZE LEGAL14

TRAY1 OTHER SIZE TABLOID

TRAY2 PAPERSIZE CASSETTE SIZE Selects the size of paper loaded in Tray 2 (lower) if 
installed. For CUSTOM setting see X-SIZE and Y-
SIZE in “Print menu” on page 18.

TRAY2 MEDIATYPE PLAIN Selects the type of media loaded in this tray (if 
installed). This will help the printer to adjust its 
internal operating parameters, such as engine speed 
and fusing temperature, to better accommodate the 
media to be fed. For example, letterhead may 
benefit from a slightly lower fusing temperature to 
ensure that its ink does not offset.

Note: USERTYPEn are displayed only if registered in 
the host PC/Server.

TRAY2 MEDIAWEIGHT MEDIUM Adjusts the printer for the weight of paper stock 
loaded in this tray (if installed).

TRAY2 LEGAL SIZE LEGAL14

TRAY2 OTHER SIZE TABLOID

TRAY3 PAPERSIZE CASSETTE SIZE Selects the size of paper loaded in Tray 3 (lower) if 
installed. For CUSTOM setting see X-SIZE and Y-
SIZE in “Print menu” on page 18.

TRAY3 MEDIATYPE PLAIN Selects the type of media loaded in this tray (if 
installed). This will help the printer to adjust its 
internal operating parameters, such as engine speed 
and fusing temperature, to better accommodate the 
media to be fed. For example, letterhead may 
benefit from a slightly lower fusing temperature to 
ensure that its ink does not offset.

Note: USERTYPEn are displayed only if registered in 
the host PC/Server.

TRAY3 MEDIAWEIGHT MEDIUM Adjusts the printer for the weight of paper stock 
loaded in this tray (if installed).

TRAY3 LEGAL SIZE LEGAL14

TRAY3 OTHER SIZE LETTER SEF
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SYS CONFIG MENU

This menu adjusts general printer settings to suit the way you prefer to work.

MPT PAPERSIZE A4 LEF Selects the size of paper to be fed from the multi 
purpose tray. For CUSTOM setting see X-
DIMENSION and Y-DIMENSION in “Print menu” on 
page43.

MPT MEDIATYPE PLAIN Selects the type of media to be fed from the multi 
purpose tray so that the printer can adjust its 
internal parameters to better accommodate the 
selected type of media.Note: USERTYPEn are 
displayed only if registered in the host PC/Server.

MPT MEDIAWEIGHT MEDIUM Selects the media weight to be fed from the multi 
purpose tray.

UNIT OF MEASURE MILLIMETER Selects the unit of measure.

ITEM DEFAULT REMARKS

POW SAVE TIME 1 MIN Adjusts the idling time before the printer 
automatically switches into power saving mode. In 
this mode power consumption is reduced to a low 
level required to just keep the printer operating and 
ready to receive data. When a job is sent the printer 
will require a warm-up time of up to 1 minute before 
printing can begin.

SLEEP TIME 10 MIN Adjusts the power saving time before the printer 
automatically switches into sleep mode.

PERSONALITY AUTO EMULATION This item selects which industry standard emulation 
your printer should use. When set to AUTO, incoming 
data is examined and the correct emulation is 
automatically selected each time a print job is 
received.

PARA PS-PROTOCOL ASCII Selects PostScript data format for parallel port.

USB PS-PROTOCOL RAW Selects PostScript data format for USB port.

NET PS-PROTOCOL RAW Selects PostScript data format for network port.

CLRABLE WARNING ONLINE When ONLINE, non-critical warnings, such as 
requests for a different paper size, can be cleared by 
pressing the ON LINE button. When set to JOB, they 
are cleared when the print job resumes.

AUTO CONTINUE OFF Determines whether or not the printer will 
automatically recover from a memory overflow 
condition.

MANUAL TIMEOUT 60 SEC Specifies how many seconds the printer will wait for 
paper to be fed before cancelling the job.

WAIT TIMEOUT 40 SEC Specifies how many seconds the printer will wait 
when received data pauses before forcing a page 
eject. In PostScript Emulation mode the job will be 
cancelled if timeout occurs.

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC

ITEM DEFAULT REMARKS
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PCL EMULATION

This menu controls the printer’s PCL emulation.

JAM RECOVERY ON Specifies whether the printer should perform jam 
recovery after a paper jam has occurred. If ON, the 
printer will attempt to re-print any pages lost due to a 
paper jam once the jam has been cleared.

ERROR REPORT OFF If ON, the printer will print error details when a 
PostScript Emulation error occurs.

Note: Applies to PS & PCL XL only.

ITEM DEFAULT REMARKS

FONT SOURCE RESIDENT Specifies the location of the PCL default font. 
Normally this will be INTERNAL unless additional 
fonts are installed in the expansion ROM slot or 
additional fonts have been downloaded to RAM as 
permanent fonts.

FONT NO. I0 Sets the current default font number from the 
currently selected source.

FONT PITCH 10.00CPI Sets the width of the PCL default font in characters/
inch (CPI).

Default font is the fixed-pitch, scalable font. The 
value is displayed to the second decimal place

Displayed only when the font selected in Font No. is 
fixed-spacing, scalable font.

FONT HEIGHT 12.00POINT Height of the PCL default font.

Note: This menu item is displayed only when the font 
selected in Font No. is a proportional-spacing, 
scalable font.

SYMBOL SET PC-8 PCL symbol set. If the font source and number are 
changed to one which does not support the selected 
symbol set, this must be changed to an available 
symbol set for that font.

A4 PRINT WIDTH 78 COLUMN Sets the number of columns subject to Auto LF with 
A4 paper in PCL. This is the value when Auto CR/LF 
Mode is set to OFF with the 10CPI character.

WHITE PAGE SKIP OFF Selects whether blank pages are printed or not.

CR FUNCTION CR Selects whether a received carriage return character 
(0Dh) also causes a line feed.

LF FUNCTION LF Selects whether a received line feed character (0Ah) 
also causes a carriage return.

PRINT MARGIN NORMAL Sets the non-printable page area. NORMAL is PCL 
compatible.

PEN WIDTH ADJUST ON When minimum width is specified in PCL, sometimes 
a 1-dot line, looks broken.

With PEN WIDTH Adjust set to ON, when the 
minimum width is specified, the line width will be 
emphasized so as to look wider than a 1-dot line.

With PEN WIDTH Adjust set to OFF, the line will 
appear as before.

ITEM DEFAULT REMARKS
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PPR EMULATION

This menu controls the printer’s PPR emulation.

TRAY ID#

PCL T0ID 4 Sets the # to specify the MP tray for the paper feed 
destination command (ESC&l#H) in PCL5e emulation.

PCL T1ID 1 Sets the # to specify Tray 1 for the paper feed 
destination command (ESC&l#H) in PCL5e emulation.

PCL T2ID 5 Sets the # to specify Tray 2 for the paper feed 
destination command (ESC&l#H) in PCL5e emulation.

(Displayed only if Tray 2 is installed).

PCL T3ID 20 Sets the # to specify Tray 3 for the paper feed 
destination command (ESC&l#H) in PCL5e emulation.

(Displayed only if Tray 3 is installed).

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI Specifies character pitch in IBM PPR emulation.

FONT CONDENSE 12CPI to 20CPI Specifies 12CPI pitch for Condense Mode.

CHARACTER SET SET-2 Specifies a character set.

SYMBOL SET IBM-437 Specifies a symbol set.

LETTER O STYLE DISABLE Specifies the style that replaces 9BH with letter o 
and 9DH with a zero

ZERO CHARACTER NORMAL Sets the zero to be slashed or unslashed.

LINE PITCH 6 LPI Specifies the line spacing.

WHITE PAGE SKIP OFF Selects whether blank pages are printed or not.

CR FUNCTION CR Selects whether a received carriage return character 
(0Dh) also causes a line feed.

LF FUNCTION LF Selects whether a received line feed character (0Ah) 
also causes a carriage return.

LINE LENGTH 80 COLUMN Specifies the number of characters per line.

FORM LENGTH 11.7 INCH Specifies the length of paper.

TOF POSITION 0.0INCH Specifies the distance of print from the top edge of 
the paper.

LEFT MARGIN 0.0INCH Specifies the distance of print from the left hand 
edge of the paper.

FIT TO LETTER DISABLE Sets the printing mode that can fit print data, 
equivalent to 11 inches (66 lines), in the LETTER-
size printable area.

TEXT HEIGHT SAME Sets the height of a character.

SAME: Regardless of CPI, same height

DIFF: As CPI, character heights vary.

CONT PAPER MODE OFF Sets printer for using continuous feed stationery.

ITEM DEFAULT REMARKS
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FX EMULATION

This menu controls the printer’s FX emulation.

PARALLEL MENU

This menu controls the operation of the printer’s parallel data interface. 

ITEM DEFAULT REMARKS

CHARACTER PITCH 10 CPI Specifies character pitch in this emulation.

CHARACTER SET SET-2 Specifies a character set.

SYMBOL SET IBM-437 Specifies a symbol set.

LETTER O STYLE DISABLE Specifies the style that replaces 9BH with letter o and 9DH 
with a zero

ZERO CHARACTER NORMAL Sets the zero to be slashed or unslashed.

LINE PITCH 6 LPI Specifies the line spacing.

WHITE PAGE SKIP OFF Selects whether blank pages are printed or not.

CR FUNCTION CR Selects whether a received carriage return character (0Dh) 
also causes a line feed.

LINE LENGTH 80 COLUMN Specifies the number of characters per line.

FORM LENGTH 11.7 INCH Specifies the length of paper.

TOF POSITION 0.0INCH Specifies the distance of print from the top edge of the 
paper.

LEFT MARGIN 0.0INCH Specifies the distance of print from the left hand edge of the 
paper.

FIT TO LETTER DISABLE Sets the printing mode that can fit print data, equivalent to 
11 inches (66 lines), in the LETTER-size printable area.

TEXT HEIGHT SAME Sets the height of a character.

SAME: Regardless of CPI, same height

DIFF: As CPI, character heights vary.

CONT PAPER MODE OFF Sets printer for using continuous feed stationery.

ITEM DEFAULT REMARKS

PARALLEL DISABLE Enables or disables the parallel port.1

1. If the centronics (parallel) port is enabled, the product is no longer Energy Star compliant.

BI-DIRECTION ENABLE ENABLE/DISABLE the bi-directional capability of the 
parallel interface.

ECP ENABLE Extended Capabilities Port, enables/disables this function.

ACK WIDTH NARROW Sets ACK width for compatible reception.

ACK/BUSY TIMING ACK IN BUSY Sets the order to output the BUSY and ACK signal for 
compatible reception.

I-PRIME DISABLE Sets time to enable/disable I-prime signal

OFFLINE RECEIVE DISABLE To Enable/disable of this function. When set to Enable, the 
interface retains a receive possible state even when 
switching to Offline. Interface sends the BUSY signal only 
when the receive buffer is full or a service call occurs.
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USB MENU

This menu controls the operation of the printer’s USB data interface.

ITEM DEFAULT REMARKS

USB ENABLE Enables or disables the USB data interface.

SOFT RESET DISABLE Enables or disables the SOFT RESET command.

SPEED 480Mbps Selects the interface speed.

OFFLINE RECEIVE DISABLE Enables or disables this function. When set to 
Enable, the interface retains a receive possible state 
even when switching to Offline. Interface sends the 
BUSY signal only when the receive buffer is full or a 
service call occurs.

SERIAL NUMBER ENABLE Specifies whether to ENABLE or DISABLE a USB 
serial number.

The USB serial number is used to identify the USB 
device connected to your PC.

NOTE
When you have changed any settings in the USB MENU, turn the printer OFF, 
then ON again.
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NETWORK MENU

This menu controls the operation of the printer’s 10Base-T/100Base-TX network interface.

ITEM DEFAULT REMARKS

TCP/IP ENABLE Enables or disables this network protocol.

IP VERSION IP v4 Sets up the IP version.

Operates with IP v4 only (not valid with IPv6).

Operates with both IP v4 and IPv6.

Operates with IPv6 only (not valid with IPv4).

From this stage, if IPv6 only is set from UI, for 
example Telnet, “IP v6” appears as the value of IP 
Version on the operation panel. “IP v6” will disappear 
from the value if “IP v4” or “IP v4+v6” is selected.

Display Condition: TCP/IP should be enabled.

NETBEUI DISABLE Enables or disables this network protocol.

NETBIOS OVER TCP ENABLE Sets Enable/Disable of NetBIOS over TCP protocol.

Display Conditions:
> TCP/IP should be enabled.
> IP Version is not IPv6.

NETWARE DISABLE Enables or disables this network protocol.

ETHERTALK DISABLE Enables or disables this network protocol.

FRAMETYPE AUTO Selects the Ethernet MAC layer frame type.

Display Condition: Netware should be enabled.

IP ADDRESS SET AUTO Specifies whether IP address allocation is automatic 
(DHCP) or manually assigned.

IP ADDRESS xxx.xxx.xxx.xxx Current assigned IP address. To change, press ENTER 
and use Menu buttons to increment 1st octet, then 
press ENTER again to move on to next octet. When 4th 
octet has been set, press ENTER again to register new 
address.

SUBNET MASK xxx.xxx.xxx.xxx Current assigned subnet mask. To change, proceed as 
above.

GATEWAY ADDRESS xxx.xxx.xxx.xxx Current assigned gateway address. To change, 
proceed as above.

WEB ENABLE Enables or disables Web config. facility.

TELNET DISABLE Enables or disables Telnet config. facility.

FTP DISABLE Enables or disables communication via FTP.

IPSEC DISABLE Sets Enable/Disable of IPSec. Enable via the web.

Enable: IPSec is available.

Disable: IPSec is not available.

SNMP ENABLE Enables or disables SNMP protocol.

NETWORK SCALE NORMAL Selects network size.When NORMAL is selected, 
printer can work effectively, even when connected to a 
HUB that has a spanning tree feature. However, printer 
start up time gets longer when computers are 
connected with two or three small LANs.When SMALL 
is selected, computers can cover from two or three 
small LANs to a large LAN, but may not work 
effectively when connected to a HUB that has a 
spanning tree feature.
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MAINTENANCE MENU

This menu provides access to various printer maintenance functions.

HUB LINK SETTING AUTO NEGOTIATE Sets full or half duplex for communication via a 
network hub.When AUTO is set, negotiation is done 
automatically.

FACTORY DEFAULTS EXECUTE Reloads the settings present when the unit was setup 
by the manufacturer.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE Resets menus to default settings.

SAVE MENU EXECUTE Saves the current menu settings. The last menu 
executed is saved and the menu previously saved is 
overwritten and erased.

When you press the ENTER button, the following 
confirmation message is displayed.

ARE YOU SURE? YES/NO

If you select NO, the display returns to the previous 
menu.

If you select YES, the current menu settings are 
stored and the menu is exited.

POWER SAVE ENABLE Enables or disables automatic power save mode. 
Delay before entering this mode is set in the SYS 
CONFIG MENU.

SLEEP ENABLE Sets Enable/Disable of Sleep Mode.

USB HOST POWER OFF Sets power supply for USB-HOST of the whole 
power save mode.

When Off, suppress power supply.When On, do 
normal power supply.

PAPER BLACK SET 0 Used for small adjustments when you experience 
faded print or light specks / streaking in 
monochrome printing on white paper. Select a 
higher value to reduce fading, or a lower value to 
reduce specks or streaking in high density print 
areas.

TRNSPR BLACK SET 0 As above but for mono printing on transparencies.

DARKNESS 0 Adjusts the darkness setting. Normal setting is 0.

SMR SETTING 0 Sets a correction value for uneven print quality, to 
correct print variations caused by variations in 
temperature and humidity or in print density/
frequency.

BG SETTING 0 Sets a correction value for dark-coloured paper 
printing, to correct print variations caused by 
variations in temperature and humidity or in print 
density/frequency. 

ITEM DEFAULT REMARKS
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USAGE MENU

This menu is for information only, and provides an indication of total usage of the printer 
and the expected life left in its consumable items. This is particularly useful if you do not 
have a full set of replacement consumables to hand and you need to know how soon you 
will need them.

PRINTING MENU SETTINGS

Current menu settings can be confirmed by printing a Menu Map, using the control panel.

1. Press the Menu UP arrow or DOWN arrow button until the INFORMATION MENU is 
available, then press the Enter button.

2. Press the UP arrow or DOWN arrow button until PRINT MENU MAP EXECUTE is 
displayed.

3. Press the Enter button to print the menu map. 

4. Press the Cancel or Online or the BACK button repeatedly to exit the MENU mode.

ITEM DEFAULT REMARKS

TRAY1 PAGE COUNT nnnn An indication of the number of pages printed from 
Tray1.

TRAY2 PAGE COUNT nnnn An indication of the number of pages printed from 
Tray2. (When Tray2 is installed.)

TRAY3 PAGE COUNT nnnn An indication of the number of pages printed from 
Tray3. (When Tray3 is installed.)

MPT PAGE COUNT nnnn An indication of the number of pages printed from 
the MPT.

FUSER LIFE REMAINING nnn% An indication of the remaining fuser life.

EP TONER (n.nK) REMAINING nnn% An indication of the remaining EP toner life.
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PAPER RECOMMENDATIONS
For guidance on the media you can use with your printer, which input tray and which 
ejection method to use, see the section entitled “Paper and tray information” in the 
“Specifications” chapter.

PAPER AND ENVELOPE TYPES

The manufacturer of this printer recommends the following guidelines when selecting paper 
and envelopes for use in your printer:

> Paper and envelopes should be stored flat and away from moisture, direct sunlight 
and heat sources.

> Use a smooth finished paper such as copier or laser type paper with a Sheffield 
(smoothness) rating of 250 or less. If in doubt, please ask your paper supplier.

> Use paper and envelopes that are designed for use in laser type printers.

> The use of heavily laid or textured paper will seriously impact on the life of the 
image drum.

> Do not use very smooth, shiny/glossy paper.

> Do not use heavily embossed headed paper.

> Do not use specially treated papers such as carbon paper, non-carbon paper, thermal 
paper and impact paper.

> Avoid using paper with perforations, cut-outs and ragged edges.

> Do not use envelopes with windows or metal clasps.

> Do not use envelopes with self sealing flaps.

> Avoid using damaged or curled envelopes.

TRANSPARENCIES AND ADHESIVE LABELS

The manufacturer of this printer recommends the following guidelines when selecting 
transparencies and adhesive labels for use in your printer:

> Always manually feed single sheets using the Multi Purpose Tray.

> Always use rear output.

> Media must be designed for use in laser printers or photocopiers and must be able to 
withstand 200°C for 0.1 sec. 

> Do not use media designed for use in colour laser printers and photocopiers. 

> Labels should cover entire carrier sheet.

> Carrier sheet or adhesive must not be exposed to any part of the printer.

NOTE
You can use Thermal resistant transparencies used for Over Head Projectors.
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POSTCARDS

The manufacturer of this printer recommends the following guidelines when selecting 
postcards for use in your printer:

> Always manually feed single postcards using the Multi Purpose Tray.

> Use unfolded double postcards.

> Use postcards designed for use in laser type printers.

> Do not use postcards used for ink jet printers.

> Do not use stamped or picture postcards.

INSTALLING PAPER

PAPER TRAY

1. Remove the paper tray from the printer. 

2. Fan the paper to be loaded at the edges (1) and in the middle (2) to ensure that all 
sheets are properly separated, then tap the edges of the stack on a flat surface to 
make it flush again (3).

NOTE
If printing on A6 size paper, use the multi purpose tray.

NOTE
If you are topping up the paper in a paper tray, it is recommended that you 
remove the remaining paper from the tray first then add the new paper stock 
followed by the paper you removed. This ensures that the oldest paper is used 
first to help prevent paper jams.
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3. Load paper long edge feed (LEF) (letter headed paper - face down and top edge 
towards the right of the printer) (1) up to mark (a).

4. Adjust the rear stopper, paper guides (2) and cassette tray roller (3) to the size and 
orientation of paper being used.

5. Close the paper tray gently.

If you have two trays and you are printing from the 1st (upper) tray, you can pull out 
the 2nd (lower) tray during printing to reload it. However, if printing from the 2nd 
(lower) tray, do not pull out the 1st (upper) tray. This will cause a paper jam.

If 3 trays are fitted this applies to trays 1 & 2 if printing from the 3rd (lower) tray.

To prevent paper jams:

> Do not leave space between the paper and the guides and rear stopper.

> Do not overfill the paper tray. Capacity depends on the type of paper stock.

> Do not load damaged paper.

> Do not load paper of different sizes or types at the same time.

> Do not pull the paper tray out during printing (except as described above for the 2nd 
tray).

CAUTION!

IMPORTANT: Set paper size dial (3) to the size and orientation of 
paper being used (A4 LEF in the above example).
If the paper is oriented long-edge, the Long Edge Feed (LEF) 
checkbox must be enabled in the printer driver.
If the paper is oriented short-edge, the Long Edge Feed checkbox 
must be disabled in the printer driver.
If the driver setting doesn't match the paper orientation, the 
printer will display an error message indicating that a mismatch 
has occurred.
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Face up and face down printing

For face down printing, make sure the Rear stacker is closed (the paper exits from the top 
of the printer). The Output Stacker on the top of the printer stacks printed pages face down, 
capacity 250 sheets of weight 80g/m². Pages printed in reading order (page 1 first) will be 
sorted in reading order (last page on top, facing down).

The face up stacker should be opened and the tray extension pulled out when required for 
use. (With the face up stacker either opened or closed, the driver setting of face down will 
successfully direct prints to the face down stacker.)

The face up stacker can hold up to 100 sheets 80g/m² standard paper.

Always use this stacker in conjunction with the Multi Purpose Tray or for heavyweight 
stocks to reduce the possibility of paper jams. 

See “Paper and tray information” on page 77.

Automatic feed sequence

With no optional feed trays installed, the Autotray function in the Print Menu is set by 
default to ON and the Tray sequence function is set to DOWN. In this way, if a tray runs 
out of paper, automatic feed will take place in the order Tray 1, Tray 2 (if fitted), Tray 3 (if 
fitted), Multi Purpose Tray, provided that these trays are set up for identical media. Also, 
configure the media size and media weight for the respective trays in the operator panel.

MULTI PURPOSE TRAY

1. Pull down the Multi Purpose Tray (1), extend the tray (2) and fold out the paper 
supports (3), and adjust the paper guides to the width of the paper (4).

2. Load the paper into the Multi Purpose Tray and push the set button (5). Ensure that 
the paper is loaded below the arrow level (6) to avoid paper jam.

> For single-sided printing on headed paper load the paper with the pre-printed side 
up and top edge into the printer.

> For two-sided (duplex) printing on headed paper, load the paper with the pre-
printed side down and top edge away from the printer.

NOTE
Do not exceed the paper capacity of approximately 100 sheets or 10 
envelopes depending on the media weight.
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> Envelopes should be loaded flap down, face up with the top edge to the left and 
short edge into the printer.

> Load Transparencies face up and top edge into the printer.

> For heavyweight paper or cardstock open the rear stacker to collect the printed 
output. This will give the paper a nearly straight path through the machine, 
avoiding paper jams and damage to the paper.

3. If required, set the media size and orientation in the media menu using the control 
panel, then issue the print command.

NOTE
Do not select Duplex printing on envelopes.

CAUTION!

Damage to the printer may occur if the incorrect paper setting is 
used when printing on a different media.

NOTE
> You can also set the media type in your printer driver. However, the 

printer driver settings will override the settings on the control panel.

> Remember to reset the printer for normal paper after printing on a 
different media.
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PAPER FEED, SIZE AND MEDIA SETTING

The process used to fuse (fix) the printed image to the paper involves a mixture of pressure 
and heat. Too much heat will cause lightweight paper to crease or curl and corrugations in 
transparencies. Too little heat will cause the image not to fuse fully into heavyweight paper.

Using the control panel on your printer, you can choose:

> which paper to use

> the size of the paper you wish to use

> the weight of the paper (thickness)

> the type of paper

Paper feed selection

The paper feed, paper size, paper weight and media type can be set manually on the printer 
using the control panel as follows.

1. Press the Menu UP arrow or DOWN arrow button repeatedly until PRINT MENU is 
displayed, then press the Enter button.

2. Press the UP arrow or DOWN arrow button until PAPER FEED is displayed, then press 
the Enter button.

3. Press the UP arrow or DOWN arrow button until the required paper feed is displayed.

4. Press the Enter button. An asterisk (*) appears next to the selected paper feed.

5. Press the Cancel or Online or the BACK button repeatedly to exit the MENU mode.

NOTE
Although media properties can be set in the printer driver for particular jobs, 
when filling a tray with media it is recommended that you manually set the 
printer to match the media as described here.

You must set the paper size dial as described on page 30. 

NOTE
> If the settings in the printer differ from those selected on your computer, 

the printer will not print and the LCD will display an error message.

> The following printer settings are given as a guide only. Some software 
applications require the paper feed, size and media settings to be selected 
from within the application (page setup).

> Although media properties can be set in the printer driver for particular 
jobs, it is recommended that when filling a tray with media you manually 
set the printer to match the media as described here.

NOTE
When the AUTO TRAY SWITCH is set to ON and more than one paper tray is 
fitted, paper feed automatically switches to the next available paper tray, 
providing non-stop printing.
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Paper size

Set the paper size as follows.

1. Press the Menu UP arrow or DOWN arrow button until PRINT MENU is displayed, then 
press Enter button.

2. Press either UP arrow or DOWN arrow button repeatedly until EDIT SIZE is 
displayed, then press Enter button.

3. Press either UP arrow or DOWN arrow button until the required paper size is 
displayed, then press the Enter button. An asterisk (*) appears next to the selected 
paper size.

4. Press the Cancel or Online or the BACK button repeatedly to exit the MENU mode.

5. Select the correct paper settings in the printer driver before printing the file.

Media type and weight

Set media type and weight as follows:

1. Press the Menu UP arrow or DOWN arrow button until MEDIA MENU is displayed, then 
press the Enter button.

2. Press the UP arrow or DOWN arrow button until MEDIA TYPE or MEDIA WEIGHT for the 
required tray is displayed, then press Enter button.

3. Press the UP arrow or DOWN arrow button until the required paper type or weight is 
displayed, then press the Enter button. An asterisk (*) appears next to the selected 
paper type or weight.

4. Press the Cancel or Online or the BACK button repeatedly to exit the MENU mode.

5. Select the correct paper settings in the printer driver before printing the file.

NOTE
> When using paper trays, standard paper sizes are recognised 

automatically with CASSETTE SIZE (default setting) selected. Paper size 
need only be set for custom paper sizes.

> When using the Multi Purpose Tray, the paper size has to be selected.

CAUTION!

If media type or media weight are not correctly set, print quality 
deteriorates and the fuser roller may be damaged.
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INTERFACES
Your printer is equipped with a selection of data interfaces:

1. Parallel1 – For direct connection to a PC. This port requires a bi-directional (IEEE 
1284 compliant) parallel cable.

2. USB – For connection to a PC running Windows 2000 or later or Mac OS X or later. 
This port requires a cable conforming to USB version 2.0 or above.

The operation of a printer is not assured if a USB compatible device is connected 
concurrently with other USB-compatible machines.

When connecting multiple printers of the same type, they appear as *****, ***** 
(2), ***** (3), etc. These numbers depend on the order of connecting or turning on 
each printer.

3. LAN – For network cable connection.

If you are connecting your printer directly to a stand alone computer proceed to “Printer 
drivers” on page 36.

If your printer is to be installed as a network printer, please refer to the Network Guide for 
further details on how to configure the network connection before installing the printer 
drivers.

1. If the centronics (parallel) port is enabled, the product is no longer Energy Star compliant.

NOTE
> It is not recommended that you connect serial/USB and parallel cables to 

the printer simultaneously.

> Interface cables are not supplied with your printer.

NOTE
Administrator’s authority is required when installing a network connection.



Printer drivers > 36

PRINTER DRIVERS
This chapter describes how to install a printer driver on two types of operating system – 
Windows and Mac OS X.

The printer drivers are all contained on the printer driver DVD. Please refer to the readme 
file on this DVD for the latest information on printer driver installation.

WINDOWS OPERATING SYSTEMS

1. With Windows running, insert the printer driver DVD into your DVD-ROM drive.

2. If the DVD does not run automatically, use Start > Run... and enter E:\setup 
(where E is your DVD-ROM drive) in the Open field.

3. Click on OK.

4. Select your printer model.

5. Click on Driver Installation > Install Printer Driver and follow the on-screen 
prompts to complete your printer driver installation.

6. Once the driver has been installed, the operator panel language switching utility will 
run automatically. Choose your preferred operating language. See “Changing 
language” on page 13.

INSTALLED OPTIONS

Certain options may have been installed in your printer. For those that are installed, check 
that they appear enabled on the Menu Map. 

Ensure that your options are set up in the printer driver(s) by making the appropriate 
settings on the Device Options tab (PCL emulation) and/or Device Settings tab (PS 
emulation). Refer to “Operation” on page 37 for details.

MAC OS X OPERATING SYSTEMS

Please refer to the readme file on DVD for details on installing the appropriate Mac OS X 
drivers.

INSTALLED OPTIONS

Ensure that any installed options are enabled in the printer driver.



OPERATION
This chapter provides a broad outline of how to operate your printer from either a Windows 
or a Mac OS X environment. In the former, while PCL emulation is available on all printer 
models, PS emulation is optional.

PRINTER SETTINGS IN WINDOWS

Your printer’s operator panel menus provide access to many options.

The Windows printer driver also contains settings for many of these items. Where items in 
the printer driver are the same as those in the operator panel menus, and you print 
documents from Windows, the settings in the Windows printer driver will override those 
items in the operator panel menus.

PRINTING PREFERENCES IN WINDOWS APPLICATIONS

When you choose to print your document from a Windows application program a Print 
dialogue box appears. This dialogue usually specifies the name of the printer on which you 
will print your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains a short list of the printer 
settings available in the driver, which you can choose for this document. The settings 
available from within your application are only those which you may want to change for 
specific applications or documents. Settings you change here will usually only last for as 
long as the particular application program is running.

PCL EMULATION

The tabs available are the Setup Tab, the Job Options Tab and the Image Tab.

NOTE   
The illustrations in this guide relate to Windows XP PCL and PS emulations – 
other operating system windows may appear slightly different but the 
principles are the same.
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Setup tab

1. Paper size should be the same as the page size of your document (unless you wish 
to scale the printout to fit another size), and should also be the same as the size of 
paper you will feed into the printer.

2. You can choose the source of the paper to feed, which may be Tray 1 (the standard 
paper tray), Tray 2 or Tray 3 (if you have the optional paper trays installed) or the 
Multi Purpose Tray. You can also click on the appropriate part of the screen graphic 
to select your preferred tray.

3. A variety of document finishing options can be selected, such as normal one page 
per sheet, or N-up (where N can be 2 or 4) for printing scaled down pages at more 
than one page per sheet.

4. Page orientation can be set to either portrait (tall) or landscape (wide). Both views 
can be rotated by 180 degrees.

5. Under 2-sided Printing, you can choose from auto or manual. Under manual 2-sided 
Printing you can choose to print on one side of a sheet only or to use 2-sided 
printing (duplex printing). Your printer allows you to carry out manual duplex 
printing, meaning you must pass the paper through the printer twice. For more 
information, see “2-sided printing” on page 48 The Duplex Help button also offers 
guidelines on how to carry out manual duplex printing.

6. If you have changed some printing preferences before and saved them as a set, you 
can recall them to avoid having to set them individually each time you need them.

7. A single on-screen button restores the default settings.
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Job options tab

1. The output resolution of the printed page can be set as follows.

> The High Quality setting prints at 1200 x 1200dpi and is the best option for 
printing vector objects such as graphics and text. 

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs.

> The Draft setting prints at 300 x 300dpi and is suitable for printing draft 
documents that contain mainly text.

> You can select Toner Saving to save toner for some print jobs.

2. You can print watermark text behind the main page image. This is useful for marking 
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do 
not want to use pre-printed stationery, you can create your own using Overlays. For 
more information on Overlays and Macros refer to “Overlays and Macros (Windows 
only)” on page 52. The Overlays button also offers guidelines on how to carry out 
manual duplex printing.

3. You can select your preferred job type. For more information on using the secure 
printing functions, refer to the Security Guide.

4. You can select up to 999 copies to print consecutively, although you will need to top 
up the paper tray during such a long print run.

5. Your printed pages can be scaled to fit larger or smaller stationery, within a range of 
25% to 400% of the original size.

6. In Raster (bitmap) mode, processing of the page image is done in the computer 
leaving little processing for the printer to do, although the file size may be large. In 
Vector mode, file sizes may be smaller and so transmission over a network, for 
example, may be faster. These effects are more pronounced for graphics printing 
than for text printing.

7. A single on-screen button restores the default settings.
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Image tab

1. Dithering produces an intermediate greyscale by adjusting the combination of dots 
used in printing. Selecting a setting determines the degree of detail with which a 
graphics image will be printed. Mesh determines that a screen of dots is used for 
dithering while Line Art determines that an array of lines is used for dithering.

2. Select dithering texture by setting the size of dots used in the halftone screen.

3. Set this control to print greyscale effects in black without dithering. Select the 
check-box to disable greyscale printing or de-select the check-box to enable 
greyscale printing.

4. You can manually adjust brightness (the higher the setting the brighter the print) 
and contrast (the higher the setting the greater the contrast).

5. A single on-screen button restores the default settings.
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PS EMULATION

The tabs available are the Layout Tab, the Paper/Quality Tab and the Job Options Tab.

Layout tab

1. Page orientation can be set to portrait (tall), landscape (wide) or landscape rotated 
by 180 degrees.

2. Print on both sides (duplex printing) can be set to long edge or short edge of the 
document.

3. Printed page order can be set as front to back or back to front of the document.

4. Set the number of pages to be printed on a single sheet. You can also set it to print 
a booklet.
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5. Click the Advanced button to be able to set further document options as follows:

1. Select the required printed paper size.

2. You can substitute another font for TrueType Font.

3. You can set other document options as required, including PostScript options and 
printer features.

Paper/Quality tab

You can set the paper source or leave it as automatic selection and by using the Advanced 
button you have access to the same set of options as described above for the Layout Tab.
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Job options tab

1. The output resolution of the printed page can be set as follows.

> The High Quality setting prints at 1200 x 1200dpi and is the best option for 
printing vector objects such as graphics and text.

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs. 

> You can select Toner Saving to save toner for some print jobs.

2. You can print watermark text behind the main page image. This is useful for marking 
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do 
not want to use pre-printed stationery, you can create your own using Overlays. For 
more information on Overlays and Macros, refer to “Overlays and Macros (Windows 
only)” on page 52. The Overlays button also offers guidelines on how to carry out 
manual duplex printing.

3. You can select your preferred job type. For more information on using the secure 
printing functions, refer to the Security Guide.

4. You can select up to 999 copies to print consecutively, although you will need to top 
up the paper tray during such a long print run.

5. Your printed pages can be scaled to fit larger or smaller stationery.

6. Using the Advanced button gives you access to the facility to set mirror image 
printing and negative image printing.

7. A single on-screen button restores the default settings.
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SETTING FROM WINDOWS CONTROL PANEL

When you open the driver properties window directly from Windows, rather than from 
within an application program, a somewhat more extensive range of settings is provided. 
Changes made here will generally affect all documents you print from Windows 
applications, and will be remembered from one Windows session to the next.

PCL emulation

The main tabs are the General Tab, Advanced Tab and Device Options Tab.

General tab

1. This area lists some of the main features of your printer, including optional items.

2. This button opens the same windows as described earlier for items which can be set 
from within application programs. Changes you make here, however, will become 
the new default settings for all Windows applications.

3. This button prints a test page to ensure that your printer is working.

NOTE
The above features are provided by the Windows XP operating system and will 
vary with other operating systems.
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Advanced tab

1. You can specify which times of day your printer will be available.

2. Indicates current priority, from 1 (lowest) to 99 (highest). Highest priority 
documents will print first.

3. Specifies that documents should be spooled (stored in a special print file) before 
being printed. The document is then printed in the background, allowing your 
application program to become available more quickly. Options follow:

(a) This specifies that printing should not start until the last page has been spooled. 
If your application program needs a lot of time for further computation in the 
middle of printing, causing the print job to pause for more than a short period, 
the printer could prematurely assume that the document has finished. Selecting 
this option would prevent that situation, but printing will be completed a little 
later, as the start is delayed.

(b) This is the opposite choice to the one above. Printing starts as soon as possible 
after the document begins spooling.

4. This specifies that the document should not be spooled, but printed directly. Your 
application will not normally be ready for further use until the print job is complete. 
This requires less disk space on your computer, since there is no spool file.

5. Directs the spooler to check the document setup and match it to the printer setup 
before sending the document to print. If a mismatch is detected, the document is 
held in the print queue and does not print until the printer setup is changed and the 
document restarted from the print queue. Mismatched documents in the queue will 
not prevent correctly matched documents from printing.

6. Specifies that the spooler should favour documents which have completed spooling 
when deciding which document to print next, even if completed documents are lower 
priority than documents which are still spooling. If no documents have completed 
spooling, the spooler will favour larger spooling documents over shorter ones. Use 
this option if you want to maximise printer efficiency. When this option is disabled 
the spooler chooses documents based only on their priority settings.

7. Specifies that the spooler should not delete documents after they are completed. 
This allows documents to be re submitted to the printer from the spooler instead of 
printing again from the application program. If you use this option frequently it will 
require large amounts of disk space on your computer.

8. Specifies whether advanced features, such as pages per sheet, are available, 
depending on your printer. For normal printing keep this option enabled. If 
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compatibility problems occur you can disable the feature. However, these advanced 
options may then not be available, even though the hardware might support them.

9. This button provides access to the same setup windows as when printing from 
applications. Changes made via the Windows Control Panel become the Windows 
default settings.

10. You can design and specify a separator page that prints between documents. This is 
particularly useful on a shared printer to help each user find their own documents in 
the output stack.

Device options tab

In this window you can select which optional upgrades are installed on your printer. See 
“Installing options” on page 74.

NOTE
The above features are provided by the Windows XP operating system and will 
vary with other operating systems.
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PS emulation

The main tabs are the General Tab, Advanced Tab and Device Settings Tab. The 
General and Advanced tabs are the same as for PCL emulation described earlier.

Device settings tab

1. You can set the desired paper sizes in each of the available paper feed trays.

2. You can make a variety of font settings depending on your application.

3. You can set which optional upgrades are installed on your printer. See “Installing 
options” on page 74.

PRINTER SETTINGS IN MAC OS X
Refer to the readme file on the drivers DVD, and the online help provided in the driver 
software.
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2-SIDED PRINTING 
The duplex unit adds the function of two-sided printing, using less paper and making large 
documents easier to handle. It also enables booklet printing, which uses even less paper.

You can print using Auto Duplex or Manual Duplex function.

AUTO DUPLEX PRINTING

This printer provides automatic two-sided printing only for Letter, A4, B5, Executive, Legal 
13, Legal 13.5 and Legal 14, using paper stocks from 60 - 105g/m².

To carry out Auto Duplex Printing:

1. Select File > Print and click the Properties button. 

2. Select the input tray (Tray1, Tray2 (optional) or Multi Purpose Tray) from the Source 
drop down menu.

3. In the Duplex printing drop down menu, select either Long Edge (Auto) or Short 
Edge (Auto) according to your printing preferences. 

4. If you require further information, click the Duplex Help button.

5. Click the Print button.

MANUAL DUPLEX PRINTING USING THE PAPER TRAY (WINDOWS ONLY) 

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the printer 
twice. You can carry out 2-sided printing using the Paper Tray or the Multi Purpose Tray. 
You can use A4, A5, A6, B5, Letter, Legal 13, 13.5 and 14, Statement, Executive and 
Custom paper sizes, using paper stocks from 60 - 176g/m². 

1. Ensure that there is enough paper in the Paper Tray to carry out the print job. 

2. Select File > Print and click the Properties button. 

3. Select Tray1 from the Source drop down.

NOTE
The steps in the process relate to Windows XP PCL. Other operating system 
windows may appear slightly different, but the principles are the same.

NOTE
Manual Duplex printing is available only for Windows PCL Driver.

NOTE
> You cannot use A6 paper size for printing from Tray 2 or Tray 3 (options).

> You can print on Legal 13.5 paper only from Tray1, Tray 2 (option), Tray 3 
(option) and when using Auto Duplex function.
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4. In the 2-sided printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. If you require further 
information, click the Duplex Help button. Then, click the Print button. 

5. Every second page (1) of your document is printed first. When this is complete, a 
message appears on screen prompting you to take the paper, flip it and replace it in 
the Paper Tray. 

6. Open the Paper Tray (2). 
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7. Take the printed paper from the Output Stacker (3) and place it in the Paper Tray, 
ensuring that the printed side is facing up and the bottom of the page facing into the 
printer (4). 

8. Close the Paper Tray and press the Online (5) button. The message window should 
disappear from your screen and the document finishes printing the remaining pages 
of your document. 

MANUAL DUPLEX PRINTING USING THE MULTI PURPOSE TRAY 
1. Position the paper guides on the Multi Purpose Tray according to the paper size.

2. Place paper one sheet at a time in the Multi Purpose Tray. The paper is automatically 
gripped in position.

3. Select File > Print to display the Print dialog box.

4. Click the Properties button.

5. Select the Multi Purpose Tray from the Source drop down.

6. On the 2-sided printing drop down menu, select either Long Edge (Manual) or 
Short Edge (Manual) according to your printing preferences. If you require further 
information, click the Duplex Help button.

7. When every second page has printed, take the paper from the output stacker.

NOTE
You must press the Online button to start the printing for other side. The 
default time is set to one minute, failing which, the data is deleted and not 
printed.
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8. Set the paper one page at a time in the Multi Purpose Tray with the printed side 
facing down and the top of the page facing into the printer. Ensure that the paper is 
gripped in place.

9. Press the Online button. The remaining pages of your document print on the blank 
side of the paper, one sheet at a time as you feed it into the Multi Purpose Tray.
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OVERLAYS AND MACROS (WINDOWS ONLY)

WHAT ARE OVERLAYS AND MACROS?
If you would like to print on special stationery, such as forms and letterhead, but do not 
want to use pre-printed stationery, you can create your own using these advanced 
features.

You can use PostScript overlays to generate all your special stationery and store it in the 
printer for use whenever you need it. If you have chosen to install the PCL driver, macros 
perform a similar function.

You can create several overlays or macros, and combine them in any way you like to 
produce a variety of forms and other special stationery. Each image can be printed on just 
the first page of a document, on all pages, on alternate pages, or just the pages that you 
specify.

CREATING POSTSCRIPT OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer 
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on DVD with your printer 
to create a “project file,” import the.PRN file(s), and download the generated filter 
(.HST) file to the printer. The project file will contain one or more overlay images 
which are functionally related, such as the cover page and the continuation page 
images for business letters.

3. Use downloaded files to define your overlays ready for use when printing your 
documents.

When printing overlay files to disk, do not select any special features, such as two-sided 
printing or multiple copies. These are not appropriate to overlays, they apply only to your 
final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required 
overlay image and save it.

2. Open your application’s Print… dialogue.

3. Make sure that the selected printer name (1) is 
that of your PostScript printer driver.

4. Select the Print To File (2) option.

5. Click the Properties button (3) to open the 
Document Properties window.

6. On the Job Options tab, click the Overlay button.

7. On the Overlay window, choose Create Form from the 
drop-down list (4).

8. Click OK to close the Document Properties window.

9. Click OK again to close the Print dialogue.

10. When prompted for a print file name, enter a 
meaningful name with the extension.PRN.

11. Close your application.
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CREATE AND DOWNLOAD THE PROJECT

1. From the Windows Start menu, start Storage Device Manager (SDM) and allow 
SDM to discover the printer.

2. Choose Projects > New Project.

3. Choose Projects > Add File to Project.

4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the.PRN files are stored and select one or more of these 
to include in your overlay set.

You can have more than one printer (.PRN) file in a project. For example, one for top 
pages and another for continuation pages. Use standard Windows techniques (Shift 
or Ctrl keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project.

7. When a message box appears confirming that a filter file has been created, click OK 
to clear the message.

8. The project window will display one.HST file for each printer file added. Make a 
careful note of each of these names. Ensure that you note them exactly as they 
appear, they are case sensitive, and you will need them later.

9. Choose Projects > Save Project and enter a meaningful name (e.g. “Letter 
Stationery”) so that you can recognise it later if you want to modify it.

10. Choose Projects > Send Project Files to Printer to download the project to the 
printer.

If you have a storage device in the printer, SDM will automatically download files to 
it. If not, SDM will download files to flash memory. If you have a hard disk but still 
prefer to download to flash memory, double-click the file name in the Project window 
and under Volume, type in %Flash0% and then click OK.

11. When the message “Command Issued” appears confirming that the download is 
complete, click OK to clear the message.

TEST PRINTING THE OVERLAY

1. Click on the printer icon for the relevant printer and choose Printers > Test Form.

2. In the Test PostScript Form window, to test each overlay select it and click OK. There 
will be a short pause while the printer processes the form, and then it will print.

3. When each overlay has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects > Exit to close 
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start 
menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing 
Preferences from the pop-up menu.

3. In the Overlay window, click the New button.
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4. In the Define Overlays window, enter a suitable name (1) 
for this overlay and choose which page(s) (2) of your 
documents will use this overlay.

5. Enter the name of the overlay file (3) exactly as it appeared 
in the Storage Device Manager project window. Remember 
that this name is case sensitive.

If you forgot to note the overlay names when you created 
them, you can find them using Storage Device Manager to 
view the project file, or the printer’s Information Menu to 
print a file list and identify them from there.

6. Click Add (4) to add this overlay into the defined overlays list.

7. Click OK to close the Define Overlay window.

The new overlay now appears in the Defined Overlays list in the printer properties 
window.

8. Repeat the above procedure if you wish to define more overlays.

9. When done, click OK to close the printer properties window.

Your new overlays are now ready and available to be used for any future documents you 
wish.

PRINTING WITH POSTSCRIPT OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you 
wish. The example illustrated here uses two overlays for business letters. The first prints 
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. 
Remember, if necessary, to format the document so that it will fit within the 
appropriate space.

2. Open your application’s Print… dialogue and choose any options you will require, 
ensuring that the target printer is your PostScript printer driver in which the overlays 
have been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Job Options tab, click the Overlay button.

5. On the Overlays window, choose Use Overlay from the 
drop-down list (1).

6. Click on the first overlay (2) you wish to use. In this 
example it is the Cover Page overlay. Then click the 
Add button (3).

7. If you want to use another overlay, in this case it is the 
Continuation page, click the second overlay (4) and 
then click the Add button (3) again.

8. When you have selected all the overlays you want to 
use for this document, click OK.

9. Finally, in your application’s print dialogue, click OK to begin printing.
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CREATING PCL OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer 
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on DVD with your printer 
to create a “project file,” import the .PRN file, and download the generated filter 
(.BIN) files to the printer.

3. Use downloaded files to define your overlay ready for use with any future document.

When printing files to disk, do not select any special features, such as two-sided 
printing or multiple copies. These are not appropriate to macros, they apply only to 
your final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required 
image and save it.

2. Open your application’s Print… dialogue.

3. Make sure that the selected printer name (1) is that of 
your PCL printer driver.

4. Select the Print To File (2) option.

5. When prompted for a print file name, enter a 
meaningful name with the extension .PRN .

6. Close your application.

CREATE AND DOWNLOAD MACROS

1. From the Windows Start menu, start Storage Device Manager (SDM) and allow 
SDM to discover the printer.

2. Choose Projects > New Project to start a new project.

3. Choose Projects > Filter Macro File. The Filter Printer Patterns dialogue box 
appears. Make any adjustments in the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave all the colour command 
filters checked, the black oval will print as a black rectangle when the overlay is used. 
To maintain the oval shape, turn off (deselect) the “Configure Image Data,” “Palette 
ID” and “Palette Control” filters.

4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the overlay .PRN files are stored and select one or more 
of these to include in your overlay set.

You can have more than one macro file in a project. For example, one for top pages 
and another for continuation pages. Use standard Windows techniques (Shift or Ctrl 
keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project. (You can also drag and drop files 
from Windows Explorer directly into the project window if you prefer.) When a 
message box appears confirming that a filter file has been created, click OK to clear 
the message.

7. The project window will display one .BIN file for each printer file added. Make a 
careful note of the name and ID number for each of the files. You will need them 
later.
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If you wish to edit the names or ID numbers, double-click the file entry and edit the 
details. Volume details are as follows:

0 = printer’s storage device PCL partition;
1 = printer’s storage device Common partition;
%disk0% = printer’s storage device PostScript partition;
2 = flash memory PCL
%Flash0% = flash memory PostScript

Note that the names are case sensitive, and will be needed later exactly as they 
appear in this list.

8. Choose Projects > Save Project and enter a meaningful name (e.g. “Letter 
Stationery”) so that you can recognise it.

9. Choose Projects > Send Project Files to Printer to download the project to the 
printer.

10. When the message “Command Issued” appears confirming that the download is 
complete, click OK to clear the message.

TEST PRINTING THE MACRO

1. Choose Printers > Test Macro.

2. In the Test Macro window, enter its ID number and click OK. After a short pause the 
printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects > Exit to close 
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start 
menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing 
Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click the Define Overlays 
button (1).

5. In the Define Overlays window, enter the name (a) and 
ID (b) of the required overlay, and define which 
page(s) (c) of your documents will use this overlay. Then 
click the Add button (3) to add this overlay to the list of 
defined overlays. Repeat for any other related overlays. 
When done, click the Close button (4) to close the window.

The example illustrated shows two overlays defined, one for 
a cover page and one for continuation pages.
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Remember that names and IDs of overlay files must be entered exactly as they 
appeared in the Storage Device Manager project window. Remember also that names 
are case sensitive.

If you forgot to note the overlay name or ID when you created them, you can find 
them using Storage Device Manager to view the project file, or the printer’s 
Information Menu to print a file list and identify them from there.

The new overlays will now appear in the Defined Overlays list in the printer properties 
window.

6. When done, click OK to close the printing preferences window.

Your new overlays are now ready and available to be used for any future documents you 
wish.

PRINTING WITH PCL OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you 
wish. The example illustrated here uses two overlays for business letters. The first prints 
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. 
Remember, if necessary, to format the document so that it will fit nicely within the 
plain areas on your letterhead overlay.

2. Open your application’s Print… dialogue and choose any options you will require, 
ensuring that the target printer is your PCL printer driver in which the overlays have 
been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Job Options tab, click the Overlay button.

5. On the Overlay window, check the Use active overlays 
checkbox (1).

6. In the Defined Overlays list, click on the first overlay (2) 
you wish to use, and click the Add button (3) to add it to 
the Active Overlays list. (If you want a reminder of how 
this overlay looks, click the Test Print button.)

7. If you want to use another overlay with this document, in 
this example it is the “Continuation Page” overlay, click 
this overlay (4) in the list of defined overlays, and then 
click the Add button (3) again to add the second overlay to the list of active 
overlays.

8. When the list of active overlays contains all the items you want to use, click OK.

9. Finally, click the Print button in your application’s Print dialogue to begin printing 
your document.
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MAINTENANCE

EP TONER CARTRIDGE REPLACEMENT

Only use genuine original consumables to ensure the best quality and 
performance from your hardware. Non original products may adversely affect 
your printer's performance and invalidate your warranty. 

The toner used in this printer is a very fine dry powder contained in the EP toner cartridge.

Have a sheet of paper handy so that you have somewhere to place the used cartridge while 
you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the new one came in. Follow 
any regulations, recommendations, etc., which may be in force concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, damp 
cloth to remove any residue.

Do not use hot water, and never use solvents of any kind. They will make stains permanent.

1. Press the cover release and open the printer’s top cover fully.

CAUTION!

Static sensitive devices, handle with care. 

NOTE
When the LCD display indicates EP TONER LOW, or if print appears faded, first 
open the top cover and try tapping the cartridge a few times to evenly 
distribute the toner powder. This will enable you to obtain the best “yield” from 
your EP toner cartridge.

WARNING!

> Never expose an EP toner cartridge to an open flame. It can 
cause an explosion and you can be burned.

> If you inhale any toner or get it in your eyes, drink a little water 
or bathe your eyes liberally in cold water. Seek medical 
attention immediately.

WARNING!

If the printer has been powered on, the fuser will be hot. This area 
is clearly labelled. Do not touch.
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2. Holding it by its top centre, pull the used EP toner cartridge out slowly.

3. Put the assembly down gently onto a piece of paper to prevent toner from marking 
your furniture and to avoid damaging the green drum surface.

4. Take the new EP toner cartridge out of its packaging and place it on the piece of 
paper where the old cartridge was placed. Leave its wrapping material in place for 
the moment.

5. Pack the old cartridge inside the packaging material for disposal.

6. Remove the wrapping material.

7. Holding the complete assembly by its top centre, lower it into place in the printer 
locating the pegs (1 & 2) at each end into their slots in the sides of the printer cavity 
(3).

CAUTION!

The green image drum surface at the base of the EP toner cartridge 
is very delicate and light sensitive. Do not touch it and do not 
expose it to normal room light for more than 5 minutes. If the drum 
unit needs to be out of the printer for longer than this, please wrap 
the cartridge inside a black plastic bag to keep it away from light. 
Never expose the drum to direct sunlight or very bright room 
lighting.
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8. Push the coloured lever towards the rear of the printer (lock position) to release 
toner into the image drum unit.

9. Gently wipe the LED head surface with a clean, lint free cloth.

10. Close the top cover and press it down to latch it closed.

CLEANING

...THE UNIT CASING

1. Switch the printer off.

2. Wipe the unit surface with a soft cloth moistened sparingly with water or neutral 
detergent.

3. Use a soft dry cloth to dry the unit surface.

CAUTION!

Use a clean, moist, lint-free cloth for cleaning. Do not use benzine, 
thinners or alcohol as a cleaning agent.
Maintenance > 60



4. Switch the printer on.

...THE LED HEAD

Clean the LED array whenever a new toner cartridge is installed or if there are faded vertical 
areas or light printing down a page.

There is no need to switch off the printer to clean the lens.

1. Press the cover release and open the printer’s top cover fully.

2. Gently wipe the LED head surface with a clean, lint free cloth.

3. Close the top cover and press it down to latch it closed.

...THE PAPER FEED ROLLERS

Clean the paper feed rollers if paper jams frequently occur.

1. Switch the printer off.

2. Remove the paper tray from the printer.

CAUTION!

Do not use methyl alcohol or other solvents on the LED head as 
damage to the lens surface will occur.

CAUTION!

Use a clean, moist, lint-free cloth for cleaning. Do not use benzine, 
thinners or alcohol as a cleaning agent.
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3. Gaining access through the gap left by paper tray, wipe the paper feed rollers with a 
clean, lint-free cloth moistened with water.

4. Wipe the feed roller on the paper tray.

5. Replace the paper tray.

6. Open the multi purpose tray.
Maintenance > 62



7. Lift roller assembly and wipe the feed rollers.

8. Close the multi purpose tray.
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TROUBLESHOOTING

STATUS AND ERROR MESSAGES

Your printer has been designed to give you helpful status feedback not only during normal 
operation but also if a printing problem occurs so that you can take appropriate corrective 
action.

The LCD on the printer operator panel provides the self-explanatory status and error 
messages in your chosen language.

PAPER JAMS

Provided that you follow the recommendations in this guide on use of print media, and you 
keep the media in good condition prior to use, your printer should give years of reliable 
service. However, paper jams occasionally do occur, and this section explains how to clear 
them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper 
path through the printer. When a jam occurs, the printer immediately stops, and the 
operator panel informs you of the event. If printing multiple pages (or copies), do not 
assume that having cleared an obvious sheet that others will not also be stopped 
somewhere along the path. These must also be removed in order to clear the jam fully and 
restore normal operation.

If paper jams occur frequently, clean the paper feed rollers. Refer to “...the paper feed 
rollers” on page 61.

The printer may experience a paper jam in one of three areas. 

1. INPUT JAM - paper has failed to leave the selected feed tray and enter the internal 
paper path of the printer. A typical message indicates a paper jam and identifies the 
tray to check.

2. FEED JAM - paper has entered the printer but failed to reach the exit. A typical 
message indicates a paper jam and advises you to open the top cover for access.

3. EXIT JAM - paper has reached the exit but has failed to exit completely from the 
printer. A typical message indicates an exit jam and advises you to open the top 
cover for access.

1 2 3
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INPUT JAM

1. Remove the paper tray from the printer (1).

2. Remove any crumpled or folded paper.

3. Remove any paper from the underside of the printer (2).

4. Replace the paper tray.

After successful removal of any damaged or misfed paper, the printer should continue 
printing.

FEED JAM OR EXIT JAM

1. Remove the tray and clear any misfed sheets as given above.

2. Press the cover release and open the printer’s top cover.

NOTE
The B840dn model has been illustrated below. The principles are the same for 
all models of this printer.

WARNING!

If the printer has been powered on, the fuser area will be hot. This 
area is clearly marked. Do not touch it.

CAUTION!

Never expose the EP toner cartridge to light for more than 5 
minutes. Never expose the EP toner cartridge to direct sunlight. 
Always hold the EP toner cartridge by the ends or from the top. 
Never touch the surface of the green drum inside the EP toner 
cartridge.
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3. Carefully lift out the EP toner cartridge. Be careful not to touch or scratch the green 
drum surface.

4. Remove any jammed sheets from the paper path.

5. Re-install the EP toner cartridge, ensuring that the pegs (1 & 2) correctly locate into 
the slots on each side of the printer (3).

6. Lower the top cover but do not press down to latch it closed yet. This will protect the 
drum from excessive exposure to room lighting, while you check the remaining area 
for jammed sheets.
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7. Remove any jammed paper from the fuser.

(a) To remove a sheet just entering the fuser (1), grip the trailing edge of the sheet, 
lift the fuser pressure release levers (2) up and press toward the rear to release 
the fuser’s grip on the sheet, and withdraw the sheet through the cavity area. 

(b) To remove a sheet in the fuser; pull the retaining lever (3) towards the front of 
the printer to release the fuser. Withdraw the fuser unit using the handle (4).

(c) Lift the fuser pressure release levers (2) up and press toward the rear to release 
the fuser’s grip on the sheet. Pull the trapped paper from the fuser.

(d) Replace fuser unit into the machine and move locking lever (3) toward the rear 
of the machine.

NOTE
If the sheet is well advanced into the fuser (only a short length is still visible), 
do not attempt to pull it back.
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8. Remove any jammed paper from the face down stacker.

9. Remove any jammed paper from the face up stacker. 

10. If a duplex unit is fitted, lift lever (1) and lower the duplex unit cover and pull out 
any sheets found in this area. Close the duplex unit cover.

1
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11. If the jammed paper is not ejected when the duplex unit cover is closed, turn off the 
printer.

> Remove the duplex unit and paper tray extension.

> Open the duplex unit as shown and pull out any sheets found in this area.

> Re-fit the duplex unit and paper tray extension.

12. Check for paper jam under the Paper Guard.

> Remove the EP toner cartridge as described in step 3.

> Raise the Paper Guard (1) and remove the paper. Lower the Paper Guard back 
into position.

> Re-install the EP toner cartridge as described in step 5.

1
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13. Open the Multi Purpose Tray (1). Lift the front cover release lever and lower the front 
cover. Check inside the cover for sheets in this area and remove any that you find, 
then close the cover.

14. Close the top cover and press down to latch it closed.

15. The printer will warm up and commence printing when ready. The page lost through 
the jam will normally be reprinted.

1
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PRINT QUALITY PROBLEMS

Before consulting a service representative regarding a print quality problem, check the 
table below to see if there is a solution, or something you might have overlooked.

SYMPTOM PROBLEM SOLUTION

Blank sheets printed. Image drum cartridge 
not properly installed.

Reinstall image drum cartridge.

Empty toner cartridge. Replace with a new EP toner cartridge.

Entire page prints 
faintly.

Empty toner cartridge. 
Pages get fainter when 
toner is used up.

Replace with a new EP toner cartridge.

LED array is dirty. Clean LED array.

Page has grey 
background.

Static electricity, 
generally from dry 
environments, causes 
toner to stick to 
background.

Change paper to a smoother laser bond or 
use a humidifier.

Page prints all black. Hardware problem. Contact service.

Oblong area of faint 
print appears on 
each page.

Drop out caused by 
using paper exposed to 
high humidity.

Change paper stocks, check paper storage 
environment or use a dehumidifier; check 
toner level.

Vertical white 
streaking or faint 
areas on page.

Toner is low and does 
not distribute properly, 
or the drum is worn out.

Replace with a new EP toner cartridge.

Contact service.

LED array is dirty. Clean LED array.

Vertical black lines. Hardware problem. Contact service.

Fuzzy print. LED array is dirty. Clean LED array.

Faded print. Toner low. Replace with a new EP toner cartridge.

Smeared or blotched 
print.

Dirty rollers; toner 
dropped inside printer or 
image drum problem.

Replace with a new EP toner cartridge.

Contact service.

Printed page is light/
blurred.

Is toner low? Replace with a new EP toner cartridge.

Is paper meant for laser 
printers?

Use recommended paper.

LED array is dirty. Clean LED array.

Bold characters and 
dark lines are 
smeared.

Toner is low. Replace with a new EP toner cartridge.

Print is darker than 
usual.

Darkness setting is too 
high.

Change darkness setting.

Pages curl 
excessively.

Printing on wrong side 
of paper.

Turn paper over in tray. (Note arrow on 
paper package). Install paper print side 
down in tray.

Moisture in paper. 
Improper storage.

Avoid storing paper in areas of excessive 
temperature and humidity. Store paper in 
protective wrapping.

High humidity. Recommended operating humidity: 20-
80%.
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PAPER FEED PROBLEMS

SYMPTOM PROBLEM SOLUTION

Paper Jams occur frequently. 
Multiple sheets of paper are 
fed at the same time. 

The printer is tilted. Place the paper on a stable 
and flat surface.

Paper is too thick or too thin. 
Paper is moist, folded, 
creased or warped. 

Use paper suitable for the 
printer. Avoid storing paper in 
areas of excessive 
temperature and humidity. 
Store paper in protective 
wrapping

Paper is not aligned. Align the paper edges to the 
paper guides.

Only one sheet of paper is 
loaded in the Paper tray or 
Multi Purpose tray.

Load several sheets of paper.

Sheets of paper is added to 
the existing paper stock in the 
Paper tray or Multi Purpose 
tray.

Remove existing sheets of 
paper from the tray and add 
the new sheets to them, 
ensuring alignment and then 
load the tray.

Postcards, envelopes, label 
sheets or transparencies are 
loaded in the Paper tray.

Postcards or envelopes are 
placed in the wrong 
orientation.

You cannot print using the 
Paper tray. Load postcards, 
envelopes, label sheets or 
transparencies in the Multi 
Purpose tray.

Check and load in the correct 
orientation.

Paper is not fed into the 
printer.

Improper setting is selected 
for Paper Source in the 
printer driver.

Select the correct paper 
source from the Source drop 
down menu.

The printer menu setting is 
incorrect.

Set the size of the paper in 
the Setup Menu of the printer.

Printing does not resume after 
removing jammed paper.

Printing does not resume only 
by removing paper jam.

Open and close the top cover.
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SOFTWARE PROBLEMS

Your software (operating environment, applications and printer drivers) controls the 
printing process. Make sure you have selected the right driver for use with your printer. 
See your software documentation for more information.

HARDWARE PROBLEMS

SYMPTOM PROBLEM SOLUTION

Printing is garbled. Incorrect driver is 
installed.

Install an appropriate driver.

Printer’s output is 
below rated speed.

Much of the printing 
delays will be caused by 
your application. 
Sometimes purely text 
documents will print 
slowly depending on the 
selected fonts and how 
they are transferred to 
the printer.

For maximum speed, use text in your 
document and use a printer resident font.

Size of top margin 
increases with each 
page printed.

Creeping text. Number 
of lines per page in 
software is not equal to 
number of lines per 
page of printer.

Many software packages assume 66 lines 
per page, but your printer’s default is 64. 
Adjust software accordingly, or set LINES 
Per PAGE in the soft control panel to equal 
lines per page in your software.

SYMPTOM PROBLEM SOLUTION

Graphic image prints 
partly on one page, 
partly on the next.

Insufficient printer 
memory for this image 
at this resolution.

Change the resolution, reduce the image 
size, or install more memory in your 
printer.

When you try to 
print nothing 
happens, but printer 
indicates it is ready 
to receive data.

Configuration error. Check cable connection. If more than one 
printer is available, make sure your printer 
has been selected.

Garbage prints. Incorrect cable 
configuration. Also, see 
Software Problems.

Check cable configuration, continuity, and 
length.

Printer freezes or 
displays error 
message when 
computer is 
rebooted.

Booting the computer 
while the printer is on 
can cause a 
communications error.

Turn printer off before rebooting computer.

Odours. Gases are given off by 
forms or adhesives 
passing through the hot 
fusing unit.

Make sure the forms you use can withstand 
heating, and provide adequate ventilation.

Printer is on but 
must warm up 
before a job is 
printed.

Power Save mode is set 
on to conserve energy. 
The fuser must heat up 
before you can begin 
printing the next job.

To eliminate warm up delay, change Power 
Save setting.
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INSTALLING OPTIONS
The following options are available to extend the performance of your printer:

> 256, 512MB RAM DIMM: to extend the main memory of your printer and speed up 
the processing of large files

> SD Card: to enable collating of printed pages and can be used to store overlays and 
macros, fonts, and secure or proof documents waiting to be printed

> Duplex unit (B840n only): to enable two-sided printing, using less paper and make 
large documents easier to handle

> Second/third paper tray: to increase your printer’s paper handling capacity by 530 
sheets (80g/m²) per tray

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation sheet that accompanies 
the option.

SETTING THE DRIVER DEVICE OPTIONS

Once your new upgrade has been installed, you may need to update the printer driver so 
that the additional features are available to your applications.

Accessories such as additional paper trays will only be usable if the printer driver on your 
computer knows they are there.

In some cases the hardware configuration of your machine is automatically detected when 
the driver is installed. However, it is advisable to at least check whether all of the available 
hardware features are listed in the driver.

This procedure is essential if you subsequently add extra hardware features to your 
machine after the drivers have been installed and set up.

Remember that if your printer is shared between users on different computers, the driver 
must be adjusted on each user’s machine.

WINDOWS

1. Access the driver’s Properties window.

(a) Open the Printers window (called “Printers and Faxes” in Windows XP) via the 
Start Menu or from the Windows Control Panel.

(b) Right-click the icon for this machine, and choose Properties from the pop-up 
menu.

2. Select the Device Options tab.

In the Windows XP PostScript driver the tab may be called Device Settings.

3. Set the options for any devices you have just installed.

4. Click OK to close the window and save your changes.

MAC OS X

Snow Leopard (Mac OS X 10.6) and Leopard (Mac OS X 10.5)

1. Open the Mac OS X Print & Fax Preferences.

2. Ensure your machine is selected.

3. Select Options & Supplies.
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4. Select Driver.

5. Select all hardware options appropriate to your machine and click OK.

Tiger (Mac OS X 10.4)

1. Open the Mac OS X Print & Fax Preferences.

2. Ensure your machine is selected.

3. Select Printer Setup....

4. Select the menu and choose Installable Options....

5. Select all hardware options appropriate to your machine and click Apply 
Changes….

Panther (Mac OS X 10.3)

1. Open the Mac OS X Print & Fax Preferences.

2. Select Printing.

3. Select Set Up Printers....

4. Ensure your machine is selected and select Show Info....

5. Select the menu and choose Installable Options....

6. Select all hardware options appropriate to your machine and click Apply 
Changes….
Installing options > 75



SPECIFICATIONS

GENERAL

A summary of the basic characteristics of your printer appears in the table below:

PRINTER MODEL MODEL NUMBER

B840 N21301B

ITEM SPECIFICATION

Dimensions 485mm x 521mm x 373mm (W x D x H)

Weight 28kg approximately (without optional trays)

Power supply 220 to 240VAC @ 50 - 60Hz ± 2%

Power consumption Typical: <550W

Peak: <1.2KW

Idle: <75W

Power save mode: 15W (no options installed); 17W (with options 
installed)

Sleep mode: 1.2W

Noise level Operation: <54dB(A)

Standby mode: 37dB(A)

Power saving mode: Background level

Environmental 
conditions

Operation: 10 - 32°C, 20% - 80% RH, 

Storage: -10-43°C, 10% - 90% RH

When the printer is stored, it should be in its original packaging, with no 
moisture formation.
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PAPER AND TRAY INFORMATION

Feed and ejection methods vary depending on the type, size and thickness of medium used. 
Use the chart below and the notes/symbols/terms on the following page for initial guidance. 
(Minor variations to settings may be necessary depending on user setup and environmental 
conditions).

Feed Tray Ejection 
Method

Paper type Size Weight T1 T2/
T3

MPT FU FD

Plain paper A3(SEF)

A4(LEF/SEF)

B4(SEF)

A5(SEF)

B5(LEF/SEF)

Letter(LEF/SEF)

Executive(SEF)

8K(260x368mm) (SEF) 

8K(270x390mm) (SEF)

8K(273x394mm) (SEF)

16K(184x260mm) (LEF/SEF) 

16K(195x270mm) (LEF/SEF)

16K(197x273mm) (LEF/SEF)

Tabloid (SEF)

L,ML,M,MH,H 0 0 0 0 0

Legal 14(SEF)

Legal 13.5(SEF)

Legal 13(SEF)

L,ML,M,MH,H 0 0 0 X 0

A6(SEF) L,ML,M,MH,H X X 0 0 0

B6(SEF)

Statement(SEF)

L,ML,M,MH,H X X 0 0 0

Custom

W: 76 - 297mm

L: 148 - 432mm

L,ML,M,MH,H 0 0
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A3(SEF)

A4(LEF/SEF)

B4(SEF)

A5(SEF)

B5(LEF/SEF)

Letter(LEF/SEF)

Executive(SEF)

8K(260x368mm) (SEF) 

8K(270x390mm) (SEF)

8K(273x394mm) (SEF)

16K(184x260mm) (LEF/SEF) 

16K(195x270mm) (LEF/SEF)

16K(197x273mm) (LEF/SEF)

Tabloid (SEF)

Legal 14(SEF)

Legal 13.5(SEF)

Legal 13(SEF)

UH X X 0 0 X

A6(SEF)

B6(SEF)

Statement(SEF)

UH X X 0 0 X

Custom

W: 76 - 297mm

L: 148 - 432mm

UH X X 0 0 X

Postcards - X X 0 0 X

Envelopes Com-9

Com-10

DL

C5

C6

Monarch

Custom

W: 76 - 297
L: 148 - 432

- X X 0 0 X

Labels A4

Letter

- X X 0 0 X

Transparencies A4

Letter

- X X 0 0 X

Feed Tray Ejection 
Method

Paper type Size Weight T1 T2/
T3

MPT FU FD
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Duplex Printing

Auto Manual

Paper type Size Weight T1 T2/
T3

MPT T1 T2/
T3

MPT

Plain paper A3(SEF)

A4(LEF/SEF)

B4(SEF)

B5(LEF/SEF)

Letter(LEF/SEF)

Executive(SEF)

8K(260x368mm) (SEF) 

8K(270x390mm) (SEF)

8K(273x394mm) (SEF)

Legal 14(SEF)

Legal 13.5(SEF)

Legal 13(SEF)

L,ML,M, 
MH, H

0 0 0 0 0 0

16K (184 - 260mm)(LEF/SEF)

16K (195 - 270mm)(LEF/SEF)

16K (197 - 273mm)(LEF/SEF)

L,ML,M, 
MH, H

0 0 0 0 0 0

A6(SEF)

A5(SEF)

B6(SEF)

Statement(SEF)

L,ML,M, 
MH, H

X X X 0 X 0

Custom

W: 76 - 297mm

L: 148 - 432mm

L,ML,M, 
MH, H

X X X 0

A3(SEF)

A4(LEF/SEF)

B4(SEF)

B5(SEF)

Letter(LEF/SEF)

Executive(SEF)

8K(260x368mm) (SEF) 

8K(270x390mm) (SEF)

8K(273x394mm) (SEF)

Legal 14(SEF)

Legal 13.5(SEF)

Legal 13(SEF)

UH X X X X X X

A6(SEF)

A5(SEF)

B6(SEF)

Statement(SEF)

UH X X X X X X

Custom

W: 76 - 297mm

L: 148 - 432mm

UH X X X X X X

Postcards - X X X X X X
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Envelopes Com-9

Com-10

DL

C5

C6

Monarch

Custom

W: 76 - 297
L: 148 - 432

- X X X X X X

Labels A4

Letter

- X X X X X X

Transpa-
rencies

A4

Letter

- X X X X X X

Duplex Printing

Auto Manual

Paper type Size Weight T1 T2/
T3

MPT T1 T2/
T3

MPT
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NOTES/SYMBOLS/TERMS

Notes:

1. When an optional second paper tray is used, the original tray is referred to as Tray 1 
and the optional tray as Tray 2.

2. It is possible to use custom paper sizes with the PS emulation driver.

3. Tray 1 can accommodate paper with width of 148 to 297mm and length of 182 to 
432mm.

4. Tray 2 and tray 3 can accommodate paper with width of 148 to 297mm and length of 
182 to 432mm.

5. When printing using Auto Duplex, paper will not be ejected face up.

6. The printing speed is reduced when you set the paper size of A5, A6, Postcards, 
Envelopes as Medium heavy, Heavy or Ultra heavy.

7. Change the ejection mode to face down if the paper is curled up.

8. Change the ejection mode to face up if the paper curl is large.

9. When changing media settings, allow 15 seconds for the printer to adjust to the new 
setting.

SYMBOL/
TERM

MEANING

T1 Paper Tray 1

T2 Paper Tray 2 (optional)

T3 Paper Tray 3 (optional)

MPT Multi Purpose Tray

FU Face Up printing from the rear of the printer

FD Face Down printing from the top of the printer

W, L Width, Length in mm

L Light paper weight: 60 - 66g/m2

ML Medium Light paper weight: 67 - 73g/m2

M Medium paper weight: 74 - 88g/m2

MH Medium Heavy paper weight: 89 - 104g/m2

H Heavy paper weight: 105 - 122g/m2

UH Ultra Heavy paper weight: 123g/m2 - 160g/m2

o Can be used

x Cannot be used

Can be used depending on the size.
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OKI CONTACT DETAILS
Oki Systems (UK) Limited
550 Dundee Road
Slough Trading Estate
Slough
Berkshire
SL1 4LE

Tel:+44 (0) 1753 819819
Fax:+44 (0) 1753 819899
http://www.oki.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght
Dublin 24

Tel:+353 (0) 1 4049590
Fax:+353 (0)1 4049591
http://www.oki.ie

Oki Systems Ireland Limited - 
Northern Ireland
19 Ferndale Avenue
Glengormley
BT36 5AL
Northern Ireland

Tel:+44 (0) 7767 271447
Fax:+44 (0) 1 404 9520
http://www.oki.ie

Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie

OKI Systems (Czech and Slovak), 
s.r.o.
IBC – Pobřežní 3
186 00 Praha 8
Czech Republic

Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland) GmbH
Hansaallee 187
40549 Düsseldorf

Tel: 01805/6544357**
01805/OKIHELP**

Fax: +49 (0) 211 59 33 45 
Website: 
www.okiprintingsolutions.de
info@oki.de

**0,14€/Minute aus dem dt. Festnetz 
der T-Com (Stand 11.2008)

Διανομέας των συστημάτων OKI
CPI S.A1 Rafailidou str.
177 78 Tavros
Athens
Greece 
Τel: +30 210 48 05 800 
Fax:+30 210 48 05 801 
EMail:sales@cpi.gr
Oki Systems (Iberica), S.A.U
C/Teide, 3
San Sebastian de los Reyes
28703, Madrid

Tel:+34 91 3431620
Fax: +34 91-3431624
Atención al cliente: 902 36 00 36
Website: www.oki.es

Oki Systèmes (France) S.A.
44-50 Av. du Général de Gaulle
94246 L'Hay les Roses
Paris

Tel:+33 01 46 15 80 00
Télécopie:+33 01 46 15 80 60
Website: www.oki.fr

OKI Systems (Magyarország) Kft.
Capital Square
Tower 2
7th Floor
H-1133 Budapest,
Váci út 76
Hungary

Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.
via Milano, 11,
20084 Lacchiarella (MI)

Tel:+39 (0) 2 900261 
Fax:+39 (0) 2 90026344
Website: www.oki.it

OKI Printing Solutions
Platinium Business Park II, 3rd Floor
ul. Domaniewska 42
02-672 Warsaw
Poland

Tel:+48 22 448 65 00 
Fax:+48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

Oki Systems (Ibérica) S.A.
Sucursal Portugal
Edifício Prime - 
Av. Quinta Grande 53
7º C Alfragide
2614-521 Amadora
Portugal

Tel:+351 21 470 4200
Fax:+351  21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service 
Serviço de apoio técnico ao 
Cliente
Tel: 808 200 197
E-mail : okiserv@oki.pt

OKI Europe Ltd. (Russia)
Office 702, Bldg 1
Zagorodnoye shosse
117152, Moscow

Tel: +74 095 258 6065
Fax: +74 095 258 6070
e-mail: info@oki.ru
Website: www.oki.ru

Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Österreich)
Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge

Tel: +43 223 6677 110
Drucker Support: 
+43 (0) 2236 677110-501
Fax Support: 
+43 (0) 2236 677110-502
Website: www.oki.at

OKI Europe Ltd. (Ukraine)
Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine

Tel: +380 44 537 5288
e-mail: info@oki.ua
Website: www.oki.ua

OKI Sistem ve Yazıcı Çözümleri Tic. 
Ltd. Şti.
Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul

Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr
www.okiprintingsolutions.com.tr

Oki Systems (Belgium)
Medialaan 24
1800 Vilvoorde

Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

AlphaLink Bulgaria Ltd.
2 Kukush Str.
Building "Antim Tower", fl. 6
1463 Sofia, Bulgaria

tel:  +359 2 821 1160
fax: +359 2 821 1193
Website: http://bulgaria.oki.com

OKI Printing Solutions
Herstedøstervej 27
2620 Albertslund
Danmark

Adm.: +45 43 66 65 00
Hotline: +45 43 66 65 40
Salg: +45 43 66 65 30
Fax: +45 43 66 65 90
Website: www.oki.dk

Oki Systems (Finland) Oy
Polaris Capella
Vänrikinkuja 3
02600 Espoo

Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809
Website: www.oki.fi

Oki Systems (Holland) b.v.
Neptunustraat 27-29
2132 JA Hoofddorp

Helpdesk: 0800 5667654
Tel:+31 (0) 23 55 63 740
Fax:+31 (0) 23 55 63 750
Website: www.oki.nl
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Oki Systems (Norway) AS
Tevlingveien 23
N-1081 Oslo

Tel:+47 (0) 63 89 36 00
Telefax:+47 (0) 63 89 36 01
Ordrefax:+47 (0) 63 89 36 02
Website: www.oki.no

General Systems S.R.L. 
(Romania)
Sos. Bucuresti-Ploiesti Nr. 135. 
Bucharest 1
Romania

Tel: +40 21 303 3138
Fax: +40 21303 3150
Website: http://romania.oki.com

Var vänlig kontakta din Återförsäljare 
i första hand, för konsultation. I andra 
hand kontakta

Oki Systems (Sweden) AB
Borgafjordsgatan 7
Box 1191
164 26 Kista

Tel. +46 (0) 8 634 37 00
e-mail: 
info@oki.se för allmänna frågor om 
Oki produkter

support@oki.se för teknisk support 
gällandes Oki produkter

Vardagar: 08.30 - 12.00, 
13.00 - 16.00
Website: www.oki.se

Oki Systems (Schweiz)
Baslerstrasse 15
CH-4310 Rheinfelden

Support deutsch +41 61 827 94 81
Support français +41 61 827 94 82
Support italiano +41 061 827 9473
Tel: +41 61 827 9494
Website: www.oki.ch
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